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Введение 

С целью улучшения оценок адекватности формализации 

моделей и повышения эффективности функционирования регу-

ляторов и систем автоматического управления (САУ) в условиях 

неопределенности информации о динамическом поведении 

сложных объектов управления или о внешней среде в традици-

онные методы проектирования уже давно включают качествен-

ные признаки при описании моделей процессов управления. 

Обычно к качественным признакам относятся такие понятия, 

как грубость, чувствительность, устойчивость, адаптация и др. 

Учет и проверка таких качественных признаков при проектиро-

вании регуляторов и САУ позволяют существенно снизить тре-

бования к формированию и исследованию неклассических кри-

териев оптимизации. Поиск экстремума по неклассическим кри-

териям оптимизации приводит к необходимости исследования 

аналогов логико-динамических моделей процессов управления с 

последующей их лингвистической аппроксимацией. 

Анализ результатов имитационного моделирования и 

практического применения качественных признаков в лингви-

стической аппроксимации конкретных структур нечетких регу-

ляторов и САУ подтвердил высокую эффективность новой ин-

теллектуальной технологии при создании гибких мобильных 

систем управления сложными (слабо структурированными) 

промышленными объектами. 

Судьба нечеткой логики (fuzzy logic) как нового научного 

направления во многом сходна с ее содержанием — необычна, 

сложна и парадоксальна. Достаточно сказать, что еще в 1989 г. 

Национальный научный фонд США обсуждал вопрос об исклю-

чении fuzzy logic из всех институтских учебников, а годом поз-

же Комитет по контролю над экспортом (COCOM) внес ее в 

список критически важных оборонных технологий, не подле-

жащих экспорту потенциальному противнику. Страсти значи-

тельно улеглись в настоящее время.  

Сегодня элементы нечеткой логики можно найти в десят-

ках промышленных изделий — от систем управления электро-
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поездами и боевыми вертолетами до пылесосов и стиральных 

машин.  

В основе нечеткой логики лежит теория нечетких мно-

жеств, изложенная в серии работ Лотфи Заде (Lotfi Zadeh) в 

1965–1973 гг. Он расширил классическое канторовское понятие 

множества, допустив, что характеристическая функция (функ-

ция принадлежности элемента множеству) может принимать 

любые значения в интервале [0, 1], а не только значения 0 либо 

1. Л. Заде определил также ряд операций над нечеткими множе-

ствами и предложил обобщение известных методов логического 

вывода. 

Основная идея состояла в том, что человеческий способ 

рассуждений, опирающийся на естественный язык, не может 

быть описан в рамках традиционных математических форма-

лизмов. Этим формализмам присуща строгая однозначность ин-

терпретации, а все, что связано с использованием естественного 

языка, имеет многозначную интерпретацию. С самого начала 

основная прагматическая цель Заде — создание аппарата, спо-

собного моделировать человеческие рассуждения и объяснять 

человеческие приемы принятия решений в ходе решения раз-

личных задач, привлекая в эту область многочисленную армию 

прикладников. Идеи Заде и его последователей находят приме-

нение при создании систем, понимающих тексты на естествен-

ном языке, при создании планирующих систем, опирающихся на 

неполную информацию, при обработке зрительных сигналов, 

при управлении техническими, социальными и экономическими 

системами, в системах искусственного интеллекта и робототех-

нических системах. 

Надо сказать, что понятие нечеткого множества вполне со-

гласуется с нашими интуитивными представлениями об окру-

жающем мире. Большая часть используемых нами понятий по 

своей природе нечетки и размыты, и попытка загнать их в шоры 

двоичной логики приводит к недопустимым искажениям. Возь-

мите любой из терминов, которыми мы пользуемся в повседнев-

ных дорожных ситуациях: «притормози», «возьми правее», «не-

много поднажми» и др. Становится понятным кризис традици-
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онных экспертных систем и АСУ, оказавшихся неспособными 

справиться с многообразием и нечеткостью реальных задач.  

В ряде случаев нечеткие регуляторы способны обеспечить 

более высокие показатели качества переходных процессов по 

сравнению с классическими законами. Использование ПИД-

регуляторов в системах подчиненного регулирования позволяет 

добиться хорошего качества переходных процессов. Однако 

ПИД-регуляторы не дают ожидаемого результата при изменяю-

щихся во времени параметрах системы, а также при наличии в 

ее структуре неучтенных нелинейностей. Применение в струк-

туре привода нечеткого регулятора способно придать системе 

свойство невосприимчивости к стохастическим ограниченным 

изменениям параметров системы и внешних возмущений.  

На сегодняшний день с помощью нечеткой логики реали-

зованы тысячи проектов — от посудомоечных машин, автомо-

билей и фотокамер с автофокусировкой в потребительском сек-

торе до контроллеров поточного производства, атомных реакто-

ров, аэрокосмических систем и систем военного назначения. Та-

ким образом, изучение нечетких алгоритмов управления стано-

вится неотъемлемой задачей современного инженера. 

Целью этого методического пособия является разработка и 

исследование методов нечеткого регулирования, позволяющих 

повысить показатели регулирования скорости электропривода. 

Для достижения данной цели решаются следующие задачи: раз-

работка нечеткого логического регулятора с помощью пакета 

Fuzzy Logic Toolbox; отладка нечеткого логического регулятора; 

составление базы правил нечеткого логического регулятора; оп-

тимизация показателей регулирования скорости привода. 
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1. Общие теоретические положения 
по нечеткой логике 

1.1. Определение структуры 
нечеткого логического регулятора 

Современный уровень развития промышленности требует 

комплексного подхода при разработке систем автоматического 

регулирования техническими объектами. Это обусловлено, с од-

ной стороны, необходимостью повышения качества управления 

при минимальных затратах на создание и эксплуатацию систем, 

с другой стороны — усложнением структуры объекта управле-

ния, функций, выполняемых им, и, как следствие, увеличением 

факторов неопределенности, которые необходимо учитывать 

для управления объектом. 

В настоящее время наиболее широкое применение при ре-

шении практических задач получили нечеткие логические регу-

ляторы, позволяющие на основании лингвистической информа-

ции, полученной от опытного оператора, управлять сложными, 

плохо формализуемыми процессами. 

Для простейших нечетких алгоритмов рассматриваются 

функции входа и выхода и не используются функции переходов 

и операций. Этот тип алгоритмов получил широкое распростра-

нение при формализации опыта человека-оператора, управляю-

щего технологическим процессом. Такие алгоритмы называются 

нечеткими логическими регуляторами. 

Структура нечеткого логического регулятора, в котором 

используются эвристические правила принятия решений, пока-

зана на рисунке 1.1. Такие регуляторы используются аналогично 

традиционным регуляторам с обратной связью.  
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Рис. 1.1 

Структура нечеткого логического регулятора 

Определение управляющих воздействий состоит из четы-

рех основных этапов: 

а) получение отклонения; 

б) преобразование значения отклонения к нечеткому виду, 

такому как «большой», «средний»; 

в) оценка входного значения по заранее сформулирован-

ным правилам принятия решения посредством композиционно-

го правила вывода; 

г) вычисление детерминированного выхода, необходимого 

для регулирования процесса. 

Описываемый здесь подход значительно расширяет сферу 

взаимодействия человек — машина посредством формализации 

нечетких алгоритмов. 

Нечеткие логические управляющие устройства характери-

зуются множеством входных и выходных переменных, опреде-

ляющих структуру регулятора; множеством лингвистических 

правил (схемы нечетких рассуждений); нечетким языком. В ка-

честве входных параметров могут быть значения ошибки, инте-

грал ошибки, значение контролируемых параметров и т. д. В ка-

честве выходной переменной выбирается входное управляющее 

воздействие управляемой системы. 

Для обеспечения необходимых качеств переходных про-

цессов была выбрана структура системы с двумя входными ко-

ординатами (рис. 1.2), которыми являются ошибка по скорости и 

ускорение. Выходной координатой разрабатываемой системы 
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является приращение напряжения управления преобразователем 

dU относительно предыдущего значения. 

 

Рис. 1.2 

Структура регулятора на основе нечеткой логики 

Составление и анализ идеализированной математической 

модели системы стабилизации проводится с помощью пакета 

Simulink среды Matlab 6, синтез нечетких регуляторов ведется с 

помощью пакета Fuzzy Logic Toolbox version 2.1 среды Matlab 6. 

На выходе нечеткого регулятора формируется величина управ-

ляющего воздействия. Выход dU используется для вывода вели-

чины приращения управляющего воздействия на текущем пере-

счете блока. 

Значение выхода формируется по следующему алгоритму: 

U = U1 + k  dU,   (1.1) 

где U — управляющее воздействие, В; U1 – управляющее воз-

действие на предыдущем такте, В; k — коэффициент усиления 

приращения управляющего воздействия; dU — приращение 

управляющего воздействия, В. 

Блок Saturation3 предназначен для ограничения величины 

приращения управляющего воздействия, то есть ограничивает 

скорость возрастания управляющего напряжения на тиристор-

ном преобразователе. 

1.2. Графический интерфейс 
Fuzzy Logic Toolbox 

Собственные программы на основе нечеткой логики анон-

сировали такие гиганты, как IBM, Oracle и другие. Любопытно, 

что «взрыв» на рынке программных пакетов на основе нечеткой 
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логики пришелся примерно на 1995 г. Появилось более сотни 

программ, использующих нечеткую логику.  

Блок Fuzzy Logic Controller (регулятор на основе нечеткой 

логики) в пакете Simulink имеет один параметр, в котором ука-

зывается имя нечеткой системы, смоделированной в редакторе 

нечеткой системы вывода (FIS Editor) и сохраненной в рабочем 

пространстве. 

Командой (функцией) Fuzzy из режима командной строки 

запускается основная интерфейсная программа пакета Fuzzy 

Logic — редактор нечеткой системы вывода. Вид открывающе-

гося при этом окна приведен на рисунке 1.3. 

 
Рис. 1.3 

Вид окна редактора нечеткой системы вывода 

В меню File выбираем команду New Mamdani FIS (новая 

система типа Mamdani). Данная система основана на следующем 

математическом алгоритме. 

1. Нечеткость: находятся степени истинности для предпо-

сылок каждого правила: A1(x0), А2(x0), B1(y0), B2(y0). 
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2. Нечеткий вывод: находятся уровни «отсечения» для 

предпосылок каждого из правил (с использованием операции 

min): 

1 = А1(x0)  B1(y0);    (1.2) 

2 = A2(x0)  B2(y0),    (1.3) 

где через «», как и раньше, обозначена операция логического 

минимума (min), затем находятся усеченные функции принад-

лежности: 

С1(z) = (1  С1(z));   (1.4) 

C2(z) = (2  С2(z)).   (1.5) 

1. Композиция: с использованием операции max (обозна-

чаемой как «») производится объединение найденных усечен-

ных функций, что приводит к получению итогового нечеткого 

подмножества для переменной выхода с функцией принадлеж-

ности: 

(z) = С(z) = C'1(z)  C'2(z).   (1.6) 

2. Наконец, приведение к четкости (для нахождения z0) 

может приводиться несколькими способами (рис. 1.4): 

- наименьший максимум (smallest of max, som); 

- средний максимум (mean of max, mom); 

- наибольший максимум (largest of max, lom); 

- центроидный метод — как центр тяжести для кривой (z) 

(centroid); 

- бисекторный (bisector of area). 

 
Рис. 1.4 

Методы приведения к четкости 
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Алгоритм Мамдани иллюстрируется на рисунке 1.5 [2]. 

 

Рис.1.5 

Иллюстрации к алгоритму Мамдани 

Метод приведения к четкости (defuzzification — дефузи-

фикация) оставим по умолчанию: центроидный метод. 

Через пункт меню Edit > Add input добавляем в систему 

второй вход. Делая далее однократный щелчок на блоке input1 и 

в поле Name, находящемся в правой части редактора, меняем его 

имя на «Ошибка», завершая ввод имени нажатием клавиши 

Enter. Аналогичным способом устанавливаем имя «Ускорение» 

блоку input2 и dU — выходному блоку output1. Присвоим сразу 

и имя всей системе, например Pusk, выполнив это через пункт 

меню File > Save to workspace as (Сохранить в рабочем про-

странстве как...). Через пункт меню File > Save to disk as (Сохра-

нить на диске как...) сохраним систему на жестком диске. Вид 

окна FIS-редактора после задания структуры системы представ-

лен на рисунке 1.6. 

Дважды щелкнув на блоке «Ошибка», откроем окно редак-

тора функций принадлежности (рис. 1.7).  
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Рис. 1.6 

Вид окна FIS-редактора после задания структуры системы 

 

Рис. 1.7 

Окно редактора функций принадлежности 
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Для задания функций принадлежности используются ти-

повые формы приведенных ниже функций (): 

— треугольная (trimf); 

— трапецеидальная (trapmf); 

— гауссова (gaussmf); 

— двойная гауссова (gauss2mf); 

— обобщенная колоколообразная (gbellmf); 

— сигмоидальная (sigmf); 

— двойная сигмоидальная (dsigmf); 

— произведение двух сигмоидальных функций (psigmf); 

— Z-функция; 

— S-функция; 

— Pi-функция. 

Указанные функции принадлежности приведены на рисун-

ке 1.8. 

 
 

 

Рис. 1.8. Начало 

Типовые функции принадлежности нечетких множеств 
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Рис. 1.8. Окончание 

Типовые функции принадлежности нечетких множеств (продолжение) 
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Конкретный вид данных функций определяется значения-

ми параметров, входящих в их аналитические представления, 

например: 

trimf ( , , , ) max min , , 0 ;
x a c x

x a b c
b a c b

         
         (1.7) 

trapmf ( , , , , ) max min ,1, , 0 ;
x a d x

x a b c d
b a c d

         
    (1.8) 

2

gaussmf ( , , ) ;
x c

x c e
  
                             (1.9) 

1
sigmf ( , , )

1 exp( ( ))
x a c

a x c


  
  (1.10) 

и т. д. 

Если по каким-либо причинам вас не устраивает ни одна 

из встроенных функций принадлежности, можно создать и ис-

пользовать собственную подходящую функцию. 

В поле Range (Диапазон) устанавливается диапазон изме-

нения «Ошибки». В меню Edit данного редактора можно вы-

брать две команды: Add MFs (добавить функции принадлежно-

сти) и Add custom MFs (добавить одну выборочную функцию 

принадлежности). При выборе Add MFs появится диалоговое 

окно (рис. 1.9), позволяющее выбрать тип (MF type) и количе-

ство (Number of MFs) функций принадлежности. 

 
Рис. 1.9 

Диалоговое окно задания типа и количества функций принадлежности 
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Выбранные функции принадлежности отображаются в 

окне редактора функций принадлежности. С помощью указателя 

мыши можно выбрать одну из функций принадлежности, после 

чего с помощью мыши ее можно подвинуть в нужную сторону, 

изменить вершину, а также увеличить основание треугольника. 

Более точную установку можно провести, изменяя числовые 

значения в поле Params (Параметры). В поле Name задается имя 

кривой (ввод каждого имени завершается нажатием клавиши 

Enter). 

Для конструирования правил необходимо дважды щелк-

нуть на среднем (белом) блоке, при этом раскроется окно редак-

тора правил (Rule Editor), показанное на рисунке 1.10. 

 
Рис. 1.10 

Окно редактора правил 

Ввод правил происходит следующим образом:  

– выбирается функция принадлежности в столбце 

«Ошибка» или значение None (Нет); 
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